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Important Information 
 

Proprietary Information 

This document contains confidential and proprietary information which is protected by copyright laws.  
Any release or distribution of the materials, without permission, is a violation of law. 

Warranty 

NO WARRANTIES OF ANY NATURE ARE EXTENDED BY THIS DOCUMENT.  Any product or related 
information described herein is only furnished pursuant and subject to the terms and conditions of the 
BioAssemblyBot® or BioBot® sale agreement.  The only warranties made by Advanced Solutions Life 
Sciences, LLC, if any, with respect to the products or software described herein are set forth in the 
BioAssemblyBot® or BioBot® sale agreement.   Advanced Solutions Life Sciences, LLC does not accept 
any financial responsibility that may result due to the use of the information in this document, including 
direct, special or consequential damages.      

Trademarks 

BioAssemblyBot® and the BioAssemblyBot® logo design, BioBot® and the BioBot® logo design, and 
TSIM® are trademarks of Advanced Solutions Life Sciences, LLC and may not be used without written 
permission. All names of other companies, products and services are the property of their respective 
owners. 

Patents 

The BioAssemblyBot® is subject to U.S. Patent No. 9,910,935 (2018). BioBot® is subject to a patent 
pending filed by Advanced Solutions Life Sciences, LLC with the U.S Patent Office. 

Copyright 

No part of this document may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, for any purpose, without the express written permission of Advanced Solutions Life 
Sciences, LLC. Under the law, reproducing includes translating into another language or format.  

As between the parties, Advanced Solutions Life Sciences, LLC.  retains title to, and ownership of, all 
proprietary rights with respect to the software contained within its products. The software is protected 
by United States copyright laws, trademark and other intellectual property laws. Therefore, the user 
must treat the software like any other copyrighted material (e.g. a book or sound recording). 
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Copyright Notice 

© 2018 Advanced Solutions Life Sciences, LLC. All rights reserved. 
Advanced Solutions Life Sciences, Inc. 
1901 Nelson Miller Parkway 
Louisville, KY 40223 
USA 
 

Disclaimer 

Every effort has been made to ensure that the information in this manual is accurate. Advanced 
Solutions Life Sciences, LLC. is not responsible for printing or clerical errors. Information in this 
document is subject to change without notice. 

License Agreements 

Any information described herein is only furnished pursuant to and subject to the terms and conditions 
of the End-User License Agreement for the Tissue Structure Information Modeling (“TSIM”) software. 
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About Tissue Structure Information Modeling (TSIM®) 
 

TSIM® is an intuitive software tool that empowers doctors and scientists to design, visualize, simulate and 
analyze 3D computer models of complex tissue structures. TSIM® provides a comprehensive platform 
including medical imaging analysis, biological construct modeling, physical simulation, and fabrication. 
Starting with industry standard data (e.g. medical imaging), TSIM® guides users through the construction 
of a biological model capable of being simulated, analyzed, and fabricated. 

Coupled with the BioAssemblyBot® or the BioBot® Basic, TSIM® provides a comprehensive integrated 
software and hardware technology platform to model and print 3D tissue structures.  

BioAssemblyBot® is an integrated tabletop workstation with a multi-axis robot that facilitates 3D tissue 
printing of composite geometric objects. The multi-axis robot design is the next stage of evolution in 3D 
printing technology and is well suited for the surgical precision required to assemble functional tissue 
structures. 

 

 

BioBot® Basic is a benchtop workstation with a unique polar coordinate printing robot.  Like the 
BioAssemblyBot®, it automatically handles material changes and pressure changes during a print.  It 
allows printing of structures in up to 5 materials, and features two swappable stages.  
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File 
The File screen allows a user to create a new model, open, or save an existing TSIM® project file, 
and enter necessary settings related to the BioAssemblyBot or Camera.  

 

New 
Creates a new TSIM® project. The user will need to select a file location and enter a name for 
the project.  

Open 
Open existing .tsim project files.  

Save or Save As 
Saves project files in a desired location. Saving creates a .tsim file. 
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Settings 

 

bio assembly bot network address – These settings are only used for entering IP address or machine 
name of the BioAssemblyBot HMI.  This allows a connection between TSIM and the BioAssemblyBot.  
Once the correct IP/machine name is entered, the user should click Accept.  The BioAssemblyBot at this 
IP/machine will be reviewed, and if found, connected to bio assembly bot text will appear against a 
green background.  If the IP/machine name is not found on the network, connection to bio assembly bot 
failed text will appear against a red background.  Please review network settings and IP/machine name, 
and retry as necessary if this occurs.  Camera framerate and exposure will allow you to change the 
streaming camera settings for the camera connected to the BAB. 

External slicer path (‘Slic3r-console.exe’) – If you chose to use Slic3r to slice the print path and use in-fill 
patterning, you can download the Slic3r program using the link in the settings dialog. After you install it, 
put the path to the Slic3r console and this option will be enabled. 
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Solid Modeling 

 

The Solid Modeling screen provides a 3D environment in which a user can create models or import 
existing models in a variety of standard imaging formats, such as STL, DICOM and NIfTI formats.  Once 
imported, the models can be used for printing on the BAB.  Complex models may be created using the 
basic set of geometric objects (box, cylinder, sphere and pyramid).  Tools are also provided (combine, 
align, sketch, volume and surface) to further manipulate models.   
 

 

The ability to undo or redo an action is made available via the two arrows in the 
top center of the Solid Modeling screen.  
 
 

 The display above shows the BioAssemblyBot® stage.  To change to the BioBot® Basic stage, click the 
“print to BioBot Basic” checkbox in the top right of the screen. 

3D viewing perspective basics 
Pan: hold down the scroll wheel or press the alt key and move the mouse 
Rotate:  
 Hold the SHIFT key, left click, hold, and move the mouse 
 Left click the View cube, hold, and move the mouse 
 Click a specific face of the View cube (top, bottom, front, back, right and left) 
Zoom in and out: 
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  Scroll the mouse wheel 
 Right click, hold, and move the mouse 

To return to the default view ~ 
Horizontal view 1 OR F2 
Left horizontal view 2 OR F3 
Overhead view 3 OR F4 

 

Orthographic / Perspective View 
Orthographic – is a means of representing a three-dimensional object in two dimensions. 

Perspective – is an approximate representation of an image as it is seen by the eye. 
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TSIM Panel 
The TSIM Panel is divided into groups.  Each group contains specific tools. 

 

The groups and tools within are: 

 Select: Selection of created objects. 

 Create Primitive:  Creation of simple solid objects. 

 Combine Solids:  Combining solid objects into more complex solid objects. 

 Move: Movement, alignment, and precise placement of objects within the build space. 

 Measure: Individual measurements of objects, edges, and faces. 

 Import: Allow 3D volumetric or polygonal datasets to be imported. 

 Volume: Allow review and modification of 3D volumetric datasets 

 Sketch: Creation and modification of 2D sketches, which can become complex solid objects. 

 Create: Custom tools to create complex 3D objects, or sets of complex 3D objects. 
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Select Tools 

The Select Solids tool is the default tool. Selecting an object will highlight the object, surround the 
object with interaction widgets, and open the Object Menu on the right-hand side of the screen.  

To select multiple objects, hold down the CTRL key, then left click each desired object. 

 

Figure 1: The selected box is highlighted with a yellow tint, and the object name is highlighted in blue in 
the Object menu.  
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Interaction Widgets 
The interaction widgets can be used to translate, rotate, and scale the object in the X, Y, and Z axes. 

 

Figure 1:  X axis interaction widget 

 

Figure 2:  Y axis interaction widget 

 

Figure 3:  Z axis interaction widget 

 Move an object: Left click the arrow, hold down, and move the mouse.  (For more ways to 
move an object, see Transform Selection and Move Tools) 

 Scale an object: Left click the center cube, hold down, and move the mouse.   (To lock the 
aspect ratio, see Transform Selection) 

 Rotate an object: Left click the large, rectangular block, hold down, and move the mouse.  
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Project Settings Menu 
The Project Settings Menu allows you to choose global options which will affect your print. 

 

Print to BioBot Basic – With this selected, the Solid Modeling screen is altered so it reflects the BioBot® 
Basic stage, rather than the BioAssemblyBot® stage. 

Print Continuously – With this selected, the print time required for a mesh print will be reduced by 
approximately 10%.  It combines pathing in a z-slice into a single path for the BioAssemblyBot® or 
BioBot® to follow.  This is left on as a default.   

Move between print layers  

.mat line height – Moves to the next layer without picking up. If you are using a well plate, this 
option is not desirable as it may impact the plate wall when moving between objects, but this is 
the fastest print option. 

Above container – This allows you to select a container model to set the move up height. This 
will prevent collisions if you are printing in a container such as a well plate. 

Printer default – This is the printer default. Consult support to see how your unit is configured. 

 

 

Combine Print Layers –With this selected, the BioAssemblyBot® or BioBot® Basic will print objects in a 
Concurrent fashion, where each object will be completed before the next is started.  Default is off, 
which prints objects in a Sequential, or layer by layer, fashion. 
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Measure tips on every tool change – With this selected, the BioAssemblyBot® will measure the tool tip 
location each time a tool is changed. If it is disabled, tip measurement will only be done one per tool for 
a single print. This can save a lot of time if your print is changing materials often, but it may not be as 
precise. 
 
Stage Overlay Type – Useful only on BioBot® Basics.  Choosing an overlay type will show the stage 
overlay on the BioBot Basic stage in the Solid Modeling screen.  
 
Stage Temperature Control – Useful only on BioAssemblyBots® which are equipped with a stage capable 
of heating or cooling.  Set this to Heated to heat the stage, Cooled to cool the stage, or None to leave 
the stage alone for an Ambient print.   

Stage Temperature – The BioAssemblyBot® must be equipped with a stage capable of heating or 
cooling.  This can be set to a value between 10-60 degrees Celsius.   

Example:  

To heat the stage, set Stage Temp. Control to Heated, and choose a temperature in the range of [your 
current ambient – 60 C] for Stage Temperature. 

 

Example:  

To cool the stage, set Stage Temp. Control to Cooled, and choose a temperature in the range of [10 C – 
your current ambient] for Stage Temperature. 

                                 

Example:  

To return the stage to an Ambient stage, set Stage Temp. Control to None.  The value in Stage 
Temperature, if any is set, will be ignored. 
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Objects Menu 

  

Figure 1: The Objects menu is displayed on the right side after selecting an object 

Select an object to display the Objects Menu. This menu contains the Objects List, Object Properties, 
Material Selection, and Transform Selection.  

 

Objects List 
The Objects List is a comprehensive list of the objects in the current model. As objects are added to the 
modeling environment, the Objects List will update. See the above figure where four objects have been 
added (Cube, Pyramid, Cylinder and Sphere) and each are displayed in the Objects List.  When these four 
objects are printed in the BioAssemblyBot®, they will be printed from the first object in the list to the last. 

The selected object in the objects list has additional options available. For example, with the cylinder 
selected, there are options to: 

 
Lock the physical attributes of the object, preventing it from being moved, 
scaled, or rotated. 

 
Make the object transparent 
 

 
Delete the object from the modeling environment. 
 

 
Hide (or unhide) the object. 
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Object Properties (Renaming an object) 
The default name of any object is the type of object. It may be helpful to assign more meaningful names 
to each object. Renaming an object can be achieved by clicking on the name of the object.  This will allow 
you to rename the object. 

  

to 
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Grouping 
Grouping – is the process of arranging 2 or more objects together in a group or groups. 

To add a group, right click in the Objects menu, then choose “Add Group” from the popup.   

 

This will create a group with the name of <Group>. 

 

To add objects to a group, in the Objects menu, drag and drop the desired objects into the newly 
created group.  This will indent the names of the objects in the group. 
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To remove objects from a group, in the Objects menu, drag and drop the desired objects from the group 
to a position outside of the group. 

 

To add a group to another group, in the Objects menu, drag and drop the group into another group to 
combine the two.  This will create a subgroup. 
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Material Selection 
In order for the BioAssemblyBot® or BioBot® Basic to print any object, there must be a material assigned 
to the object in TSIM®. Assign materials by selecting an object and choosing one of the options from the 
Material Selection section in the Objects menu.  

Hover over a material in Material Selection to display details.  This will show the material name, pressure, 
speed, acceleration, and start delay.  To open the Material Table, click Edit Material Table or right click a 
material and click Edit Material.  

Left-clicking on a  material will bring up the parameters in a separate window, viewable in the 3D viewport.
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Object Properties 

 

Use External Slicer – This option allows you to use Slic3r to do in-fill patterning. Select an object, check 
the box, and click configure slicer to configure the slicing parameters. 

 

 Number of perimeters – This is the number of solid lines printed on the outside of the object 
(shell). 

 Solid fill area below – This is the area in which no infill pattern is used on the bottom of the 
object. 

 Fill desity – the infill pattern density. 
 Fill pattern – the pattern type to use for infill 
 Fill angle – angle in which the pattern is applied 
 Number of solid top layers – number of solid layers at the top of the object with no infill. 
 Top/bottom external fill pattern – external infill pattern. 
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Use alternate tool orientation – (6 axis printers only) – This option allows you to select a face on an 
existing model to set its tool orientation for printing allowing the tool head to be in a non z-facing 
direction. 

Use alternate slicing plane– (6 axis printers only) – This will allow you to select a face as a plane to slice 
an object. Layers will orient in the direction of the selected face (face as bottom plane). 

 

Transform Selection 
The Transform Selection panel is shown in the bottom right of the application. 

  

Move an object: Change the x (width), y (depth) or z (height) values. 

Scale an object:  

- Change the xyz scale factor as a single value to scale the object in x, y, and z simultaneously. 
- Change the x scale, y scale, and z scale value to alter the size of the object by stretching or 

compressing it.   

 
If the xyz scale factor is ‘locked’, the object will be scaled uniformly, or with a locked 
aspect ratio. Changing the xyz scale factor or any of the individual lengths will provide 
for uniform scaling in the other two axes. 

  

 
If ‘unlocked’, scaling can be done along separately along the individual X, Y and Z scales.  

 
Rotate an object: Drag either the individual roll, pitch or yaw sliders under the Transform Selection 
panel.  
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Create Tools 
For all of the create tools, ESC and Enter cancel the creation. Clicking “create” in the tool menu finalizes 
the object in the chosen dimensions. 

Create a Box   

 

This tool allows you to create a simple box in the modeling environment. Also included 
is the ability to transform a selected box via interaction widgets located on the object, 
or by changing the respective property value under Transform Selection. These values 
include changing the center, scale and position of the box. 

 

To add a box in the modeling environment 
1. Click on the Create a Box icon. 
2. Click the location on the modeling environment to begin placing the Box. 
3. The size of the Box’s base can be adjusted by moving the mouse accordingly. To accept, click your 

left mouse button to set the base.   
 

 
 

4. Moving the mouse vertically will allow you to set the height of the Box. To accept, click to set the 
height. Further refinements to the dimensions of the Box can be made by manually editing the 
width/depth/height of the object in the box menu on the right hand side. 
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5. To finalize the Box, click the create button in the box menu. 

   

 
 

 

Figure 1: Setting the height of the Box Figure 2: Final Box 
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Create a Sphere 

 

This tool allows you to create a sphere in the modeling environment. Also included is 
the ability to transform a selected sphere via interaction widgets located on the object, 
or by changing the respective property value under Transform Selection. These values 
include changing the center, scale and position of the sphere. 
 

To add a sphere in the modeling environment 
1. Click on the Create a Sphere icon. 
2. Click the location in the modeling environment on which to place the sphere. 
3. The size of the sphere can be adjusted by moving your mouse. To set the size, click once more. 

You can further refine the sphere by manually entering the center’s coordinates or changing the 
value of the radius. 

4. To accept the final object, click the Create Solid button on the Sphere menu.  
 

 

 
 

 

 

Figure 1: Scaling a sphere in the modeling 
environment 

Figure 2: Final Sphere 
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Using the Cylinder Tool 

 

This tool allows you to create a cylinder in the modeling environment. Also included is 
the ability to transform a selected cylinder via interaction widgets located on the object, 
or by changing the respective property value under Transform Selection. These values 
include changing the center, radius and height of the cylinder. 

 

To add a Cylinder to the modeling environment: 
1. Click on the Create a Cylinder icon. 
2. Click the location in the modeling environment on which to place the cylinder. 
3. The size of the cylinder’s base can be adjusted by moving the mouse. To accept, click to set the 

base. 

 

Figure 1: Setting the base of the cylinder 

4. Next, adjust the height of the cylinder by moving your mouse and clicking once more to set it. 
You can further refine the dimensions of the cylinder by manually entering the center’s 
coordinates or the value of the radius or the height. 

5. To accept the final object, click the Create Solid. 

  
Figure 2: Setting the height of the cylinder 
 
 

Figure 3: Final cylinder 
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Using the Pyramid Tool 

 

This tool allows you to create a pyramid in the modeling environment. Also included is 
the ability to transform a selected pyramid via interaction widgets located on the 
object, or by changing the respective property value under Transform Selection. These 
values include changing the center, radius and height of the pyramid. 

 

To add a Pyramid to the modeling environment: 
1. Click on the Pyramid Tool icon. 
2. Click the location in the modeling environment on which to place the pyramid.  
3. The size of the pyramid’s base can be adjusted by moving the mouse. To accept, click to set the 

base. 

 

Figure 1: Setting the base of the pyramid 

4. Next, set the height of the pyramid by moving your mouse. To accept, click to set the model.  
You can further refine the dimensions of the pyramid by manually entering the center’s 
coordinates or the value of the radius or the height. 

5. To accept the final object, click the Create Solid. 

     

Figure 2: Setting the height of the pyramid Figure 3: Final pyramid 
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Combine tools 
As you build your desired objects, it will be necessary to build custom objects using a combination of the 
basic objects provided. The Combine tools allows you to perform a variety of operations, such as 

 Add one solid to another 
 Subtract one solid to another 
 Intersect one solid to another 

 

Add one solid to another 

 

This tool is used to merge together two separate object volumes so that their 
boundaries will be defined as a single region. 

 

To perform an Addition operation: 
1. Click on the first object to select it. 

 
 

2. Hold down the Ctrl key and click the second object. 

 
3. Click the Addition icon to join the two objects. The region boundary will now encompass the 

newly unified object. 
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Difference 

 

This tool is used to define a region boundary based on the subtraction of an actively 
selected object from an inactive object. 

 

To perform a Difference operation: 
1. Click on the first object to select it. 

 

2. Hold down the Ctrl key and click the second object. 
 

 
 

3. Click the Difference icon to leave the portion of the active object that does not intersect with 
the inactive object. 
 

 

 

 

 



                        TSIM User Manual              
 

31 | P a g e  
 

Intersection 

 

This tool is used to define a region boundary based on the intersection of two objects.  

 

To perform an Intersection operation: 
1. Click on the first object to select it. 

 

2. Hold down the Ctrl key and click the second object. 

  

3. Click the Intersection icon to leave the portion of the active object that intersects with both 
objects. 
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Move Tools 

Align two faces on different objects 

 

This align tool will allow you to bring together two objects, based on a point selected 
on each object. After the operation, you will still have the ability to select the 
individual objects. 

Steps 
1. Click the Align two faces icon. 
2. Select a point on the desired face on the first object. The face will be highlighted (as seen by 

the darker cube face in the image below). A red dot denotes the point of selection and when 
you move to the center a green dot will appear as well. 

 
 

3. Now select the desired point on the face of the second object. You may rotate/zoom the 
camera view to precisely select the point.  

 
 

4. The first object will move such that the two points on the selected faces will be aligned 
together.  
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Align center of one object to a point on another’s y-axis 

 

This tool allows you to align two different objects along the y-axis, based on their 
center points. After the operation, you will still have the ability to select the individual 
objects. 

Steps  
1. Click on a point on the first object. If you move to the center or corner of the face, the red 

dot will turn into a green dot to indicate that it is on a center or corner. 
2. Click on a point on the second object. 
3. The first object will move in the y-axis so that their centers line up accordingly. 

 

Align center of one object to a point on another’s x-axis 

 

This tool allows you to align two different objects along the x-axis, based on their 
center points. After the operation, you will still have the ability to select the individual 
objects. 

Steps  
1. Click on a point on the first object.  
2. Click on a point on the second object. 
3. The first object will move in the x-axis so that their centers line up accordingly. 

 

Align center of one object to a point on another’s z-axis 

 

This tool allows you to align two different objects along the z-axis, based on their 
center points. After the operation, you will still have the ability to select the individual 
objects. 

Steps  
1. Click on a point on the first object.  
2. Click on a point on the second object. 
3. The first object will move accordingly in the z-axis so that their centers line up accordingly. 
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Drag 

 

The drag tool allows you to move a selected object in different directions relative to 
the “ground”, which is determined based on your camera angle. For example, in the 
default view, dragging a model will move your object in the xy-plane. 
 

Using the Drag Tool 
1. Click on the Drag Tool. 
2. Select the object to move. A blue frame will surround your selected object and the Move menu 

will be visible on the right hand side. 
 

 
 

3. Drag the object by moving your mouse. The values contained in the Move menu will update, 
respective to the move. Alternatively, clicking on and manually editing any value in the Move 
menu will result in the object being moved by the specified amount.  
 

 
 

Lay Flat 

 

The Lay Flat tool allows you to align a selected face of a model to the platform or 
‘ground plane’. 
 

 

Steps to measure using the Lay Flat Tool 
1. Click the Lay Flat Tool.  
2. Select the desired face of the model, which is to be placed on the platform. 
3. The model will now be oriented and placed on the platform. 
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Measure 

 

This tool will allow you to draw point to point measurement lines on both the 2D image 
slices and within the 3D model. This will be useful when measuring the dimensions of 
the 3D model.  
 

 Steps to measure using the Measure Tool 
1. Click the Measure Tool. 
2. Click the starting point to begin measuring. 
3. As you move your mouse towards an end point, the measurement is dynamically displayed in 

millimeters.  
4. Clicking on the end point will affix the distance between the two spots. 
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Importing a model file 
Users may open existing model files created in external programs. Acceptable file formats include STL, 
NIfTI and DICOM. See “import” in the TSIM® Panel. 

 

 

Importing an STL file into the modeling environment: 
1. Click on the Import STL icon in the Import section. 
2. Navigate to the folder containing the STL files. 
3. Highlight the desired file and click the ‘Open’ button to import the model.  

 

 
 

4. The object will appear in the modeling environment. As in the case of objects created in TSIM, 
you will have the ability to modify the imported object via the Objects menu on the right-hand 
side. 
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Importing a NIfTI file into the modeling environment: 
1. Click on the Import NIfTI icon in the Import section. 
2. Navigate to the folder containing the NIfTI files 
3. Highlight the desired file and click the ‘Open’ button to import the model.  
4. The object will appear in the modeling environment. As in the case of objects created in TSIM, 

you will have the ability to modify the imported object via the Objects menu on the right-hand 
side. 

 

 

Importing DICOM images into the modeling environment: 
1. Click on the DICOM icon in the Import section. 
2. Navigate to the folder containing the DICOM files. 
3. Click ‘Select Folder’ to import the model.  
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Volume 

 

The Volume tool enables you to further analyze your volumetric model (NIfTI or DICOM) 
by adjusting density or opacity values. The spacing values for each axis may be modified 
as well. 
 

1. Begin by importing the volumetric file (See Importing a model file). 
2. Click on the Volume icon. 
3. Click on the imported model to highlight it. The Adjust Volume menu will now be displayed on 

the right hand side. By adjusting the individual sliders, you can change the respective value, 
which in turn updates the model. 

Note: you can still change your viewing angle while you make adjustments to the volume.  
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Sketch 
TSIM provides you with additional tool to assist you in situations requiring you to draw your own objects. 
These can be accessed via the Sketch panel and the tools available are: 

 

Create a sketch  
 

 

Modify a sketch 

 

Manage Sketch 

 

Generate Vascular Tree from parameters 

 

Creating a custom object using the ‘Create a sketch’ tool 
1. Click on the Create a sketch icon. 
2. The three individual planes will appear in yellow. To choose the plane onto which your sketch 

will be drawn, simply click on the desired plane. 
 

 
 

3. Your chosen plane will now appear highlighted in blue together with the interaction widgets. You 
may use the widgets to either move or rotate the selected plane.  
 

 Click on the Create button to begin working on your sketch.  
 If you would like to select a different plane, choose the Select a New Plane button to 

return to Step 2. 
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4. The selected plane will now be displayed as a grid and the Sketch menu will appear. Here you can 
draw custom objects by using curves, circles, points, rectangles, etc.  
 

 
 

5. Once you have completed drawing your object, right-click to stop drawing and click on the Select 
tool to return back to the Solid Modeling screen.  
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Modify Sketch 
The Modify Sketch tool allows you to make changes to an existing sketch.  

To use the tool: 

1. If you have an existing sketch, click on the Modify Sketch icon  
2. The Sketch menu will now be viewable and you can make the necessary modifications to the 

sketch. 

 
 

Manage Sketches 
More complicated objects will consist of a collection of sketches made on different planes. TSIM’s Manage 
Sketches tool allows you to modify, move, delete or hide individual sketches in a collection. Additionally, 
you may rename sketches from the default Sketch to a more relevant name. 

 

In the above figure, there are three sketches (concentric circles, triangle, square) and you can interact 
with each sketch individually via the sketches menu on the right. 
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Generate Vascular Trees from parameters 

 

TSIM allows you to create a 3D model of a vascular tree by entering in a set of input parameters via the 
Generate Vascular Tree icon in the Sketch menu. These include: 

Starting diameter (µm)  
 

Diameter of the largest vessel at the end. 
 

Order length (µm) 
 

Width of the order. 
 

Ratio 
 

Determines the decrease in size from one order to the next. 

Number of order 
 

The number of steps down in the pattern 
 

Ending diameter (µm) 
 

Diameter of the largest vessel at the end. 
 

 

Once the model is generated, you can assign a specific material to each order of the vascular tree. The 
BioAssemblyBot is a unique printer because it utilizes eight different syringe barrels containing different 
materials (more, if your BioAssemblyBot is equipped with the Dual Dispense tool) that can be changed 
automatically.  
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Surface 
The Surface panel provides you with a tool to take a sketch and convert it into a 3D model. Let us 
consider the sketch made in the previous section.  

 

Create Surface from a sketch 
To extrude the sketch into an object: 

1. Begin by clicking on the Create a surface from sketch icon.  
2. You will be presented with an overhead view of your sketch. 
3. Next, hold your CTRL key and click on each of the individual sides of the sketch. Selected sides will 

be highlighted in blue. 
4. A wire frame of the object will be displayed when all sides are connected. The Extrude menu on 

the right side will now be active and allow you to adjust both the length and resolution of the 
extrusion. 

 
 

5. Click on the Extrude button to create the final object. 
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Create Surface from sketched profiles 
In the case of the Create a Surface from sketch tool, you created a object from a single sketch profile. 
TSIM also allows you to select multiple sketches and created a new object by lofting the contours. 

In the figure below, two individual sketches exist on different planes. Begin by clicking on the Create 
Surface from sketched profiles icon from the Surface menu. Next, you need to click on the lines of the 
objects to select them. Once everything is selected, click on the Create surface button located under Loft 
Contours on the right side. 

 
 

Once completed the individual sketches will be used to form a new 3D object, as seen in the 
image below. 
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Create a Tube along a sketched curve 

 

The Create a Tube tool allows you to take an existing curve of circle and create a 3D tube. You have 
additional control over the radius and resolution of the generated tube. You can also set the radius or 
material gradient percentage at a particular sketch point. 
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Sketch a 3D Spline along a surface 

 

The Sketch A 3D Spline tool allows you to take create a spline on an existing 3D mesh.  You have 
additional control over the radius and resolution of the generated tube. You can also set the radius at a 
particular sketch point. 
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Array Pattern of objects 

 

The Array tool allows you to select an object and create a pattern of multiple of that same object.  The 
options you have are horizontal count, horizontal spacing, vertical count, vertical spacing, & yaw.  Yaw 
will generate the pattern with a rotation around the Z axis. 

 

For example, the following settings create the image below:  

horizontal count = 3 

horizontal spacing = 20.000 mm 

vertical count = 10  

vertical spacing = 20.000 mm 

yaw = 45.000 degrees 
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Generate structural supports 

 
Generates tubular supports under voids. 

 

Generate surface tubes 

 

Create surface tubes allows you to select an object to generate a tube pattern on its surface. Select the 
entity using the select and entity button and fill out the parameters. 

 Tube Diameter – size of the tubes generated 
 Tube resolution – number of faces used to construct the tube wall 
 Tub spacing – spacing between tubes generated 
 Minimum length – minimum tube length to generate.  (If the surface is too small no tube will be 

generated). 
 Max. point spacing – Maximum space between tube vert points. 
 Maximum angle – the maximum angle on the surface that the tubes will be generated. If you are 

using a sphere for example a 90deg value will cover ½ of the sphere. 
 Number of layers – Number of tube layers to generate 
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 Combine tubes – If checked, one mesh will be made for all tubes. If uncheck each tube will be an 
individual object. 
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Materials 
Materials are bioinks that are used to print out the solid models.  To modify materials, click on “Materials” 
at the top of the TSIM window.  This will bring you to the Materials screen.  Any changes made to materials 
take effect instantly. 
 

 

To add a new material, click the add material button.   

To remove an existing material, select it, and click the remove material button. 
The parameters in the list are as follows: 

Name – The name of your material.  

Description – The description of your material. This is shown the material loading screen. 

Color – Clicking on this will bring up a RGB color scale.  Choose a color in this scale.  This color is only 
used as a visual marker in TSIM®, and has no effect on the print. 

Pressure (psi) – The material in the barrel will be extruded at this pressure during the print. 

Secondary pressure (psi) – Only on BioAssemblyBots® equipped with an Ambient Dual Dispense tool.  
The material in the secondary barrel will be extruded at this pressure during the print. 

Start Delay (ms) – When the robot prints, movement will first be delayed for this number of 
milliseconds, but the pressure will still be applied, so material will extrude. 

Acceleration (mm/sec^2) – The robot will move with this acceleration while printing this material. 

Speed (mm/sec) – The robot will move with this speed while printing this material. 

Line Width (mm) – When generating the paths to build the object desired, the robot will assume that 
the material will extrude with a line width of this value. 

Line Height (mm) – When generating the paths to build the object desired, the robot will slice the object 
into layers.  The layers will have a line height of this value. 
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Layer Change Action – BioAssemblyBots® only. When pause between layers is selected, the printer will 
stop between each layer and wait for the user to open and close a door. This can be used if you need to 
do manual crosslinking and you do not want to manually pause the machine. 

Print behavior Overprint – When this setting is selected, the entire print volume will be filled with 
material even if it is not divisible by the line width. The last path will over print to ensure everything is 
filled. This can potentially cause build up over large prints if the remainder is always in the same 
location. 

Print behavior Underprint – When this setting is selected, the remainder of the print volume will be left 
empty. If a volume is not divisible by the line with, this extra area will not be printed inside the volume. 

Temp. Control – Only on BioAssemblyBots® equipped with a Heating or Cooling tool.  This can be set to 
Heated or Cooled.  If left as None, the ambient temperature will be used and the value in Temp (c) will 
be ignored.  If set to Heated or Cooled, the material will be heated or cooled to the desired temperature 
set in Temp (c).  The BioAssemblyBot® must have a Heating or Cooling tool for each material which 
requires heating or cooling. 

Temp (degrees C) – Only on BioAssemblyBots® equipped with a Heating or Cooling tool.  This is the 
temperature the Heating or Cooled tool will hit before a print, then maintain during the print. 

Light Position – Only on BioAssemblyBots® equipped with an Ambient Light Head tool.  This is the 
desired position of the light head during the print.  Currently, this is “Cure while printing” but will be 
expanded in the future. 

Lens Diameter (mm) – Only on BioAssemblyBots® equipped with an Ambient Light Head tool.  This is the 
diameter of the lens screwed on the end of the light head.  Currently, this is “12 mm” but will be 
expanded in the future. 

Light Irradiance (mw/cm^2) - Only on BioAssemblyBots® equipped with an Ambient Light Head tool.  
This is the level of irradiation applied to the material during the print.  This can vary depending on 
calibration, but is approximately 40 – 400 mw/cm^2 with a 12 mm lens.  Please see the 
BioAssemblyBot® User Manual, Calibration > Light Heads section for more details on range. 

Each of these parameters can be modified as below: 
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BioAssembly 
This tab is applicable if a BioAssemblyBot® is currently connected to the TSIM® PC.   
 
It displays a list of print jobs that are currently stored on the BioAssemblyBot®, and current camera feed 
from the BioAssemblyBot®.  In this screen, the user can: 

- View all potential print jobs available on the BioAssemblyBot® 
- View all events that have occurred on the BioAssemblyBot® 
- Send the solids shown in the Solid Modeling tab to the BioAssemblyBot® as a print job 
- Delete an existing print job on the BioAssemblyBot® 

 

Send Print Job 
Clicking this button will send all solids to the BioAssemblyBot® and create a new print job out of them, 
assuming they have a material assigned and are currently visible in the view.  The print job will be 
displayed in the Print Jobs list. 
 

Delete Print Job 
Selecting a print job in the Print Jobs list and clicking this button will delete the print job from the 
BioAssemblyBot®.  The print job will be removed from the Print Jobs list. 
 

Print Jobs tab 
This tab shows the complete list of print jobs available on the BioAssemblyBot, and also list their name, 
the number of solids in the print, number of materials in the print, and who and when the print job was 
submitted by. 
 

Events tab 
This tab shows the major Events that have occurred on the BioAssemblyBot®, such as completion of 
print jobs, door opening and closing, safety information, system startup, and system shutdown. 
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Basic 
This tab is visible and applicable if a BioBot® Basic is currently connected to the TSIM PC.  In this screen, 
the user can: 

- Recalibrate the stage height 
- Load new materials into the turret 
- Print the solids shown in the Solid Modeling tab 
- Cancel a print in progress 

 

Stage Height 
The BioBot® Basic stage or surface it is placed on may not be perfectly level.  To ensure that the prints 
created are placed correctly on the stage, the user must calibrate the stage height.  This step is 
recommended to be performed the first time a BioBot® Basic is used, if the stage is swapped out, or if 
the stage is hit forcefully.  To calibrate the stage height, follow the instructions displayed on the left side 
of the Basic tab. 

 

Load Materials 
The BioBot® Basic features a turret which can hold five materials at one time.  To remove the turret, 
click the Load Materials button.  This will make the BioBot® Basic disengage the turret.  Now the two 
thumbscrews on either side of the turret can be turned counterclockwise, and the barrel can be 
removed from the turret. 

 

Print 
The BioBot® Basic can print out the currently displayed solid objects in the Solid Modeling tab, assuming 
they have a material assigned and are currently visible in the view.  To print, click the Print button.  This 
will start a progress bar which shows the status of the current print.   

 

Cancel 
This button is disabled until a print job is started via the Print button.  If a print job needs to be canceled, 
the Cancel button can be clicked.  The BioBot® Basic will stop the current print, and will return the 
BioBot® Basic to the home position. 
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Help 
Clicking Help will bring up the default web browser on the TSIM® PC, which will allow the user to 
download the latest copy of this TSIM® User Manual. 
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About 
Clicking About will show the current version and build date of TSIM®, and will allow the user to enter all 
feedback on TSIM® desired. 
 

Submit 
The user can enter a valid email address and all feedback and comments into the Email Address and 
Comments sections.  Clicking Submit will then send this information to the Advanced Solutions Life 
Sciences team. 

 


